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® Migrating existing projects

® Examples
Where to go from here

Overview

Mobile is soon turning in to one of the most commonly applicable targets for software development. When budgeting
for application development, significant investment is reserved for the mobile platform since smartphones and, more
recently, tablets are increasingly becoming the choice of social interaction for more and more people. If you have
been already developing mobile applications, you will know the effort involved in understanding and targeting
various mobile platforms.

Using ColdFusion 11 and ColdFusion Builder 3 (comprising the ColdFusion Mobile Platform), you can quickly
build mobile applications targeting multiple platforms. You do not have to focus on the limitations and capabilities of
various mobile platforms and their supporting web browsers. You can build your mobile applications completely
using ColdFusion and can make it work equally well on desktop browsers, mobile browsers, and as installed
HTML5-based native applications.

The ColdFusion Mobile Platform aims at providing a server and development infrastructure that facilitates rapid and
robust mobile application development, debugging, packaging, and deployment. The platform comprises of the
following key components:

® The CFML Language: Added capabilities to the CFML programming language that facilitates conversion of
CFML code to mobile-friendly HTML/JavaScript, enabling easy adoption of newer web standards such as
HTML5.

® Integration with PhoneGap framework: For quickly building cross-platform mobile applications using
ColdFusion-translated JavaScript.

® ColdFusion Builder: You can use ColdFusion Builder along with ColdFusion Server for quickly building,
debugging, inspecting, and packaging mobile applications.

The following picture depicts the mobile application development workflow using the ColdFusion Mobile Platform:
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With the ease of programming that CFML facilitates and with the power of JavaScript, the ColdFusion Mobile
platform will be a robust platform and a complete solution for mobile applications development.

Leveraging the ColdFusion Mobile platform, you can rapidly develop mobile applications in CFML. Note that the
CFML constructs relevant for client-side applications development will be converted to JavaScript automatically by
ColdFusion. This means that not all CFML features, functions, tags, and other functionality are supported for
conversion to JavaScript. See Debugging mobile applicationsClient-side CFML for a list mobile-enabled tags and
functions.

Note: This version of the pre-release bundle supports debugging while building mobile applications using
ColdFusion Builder.

Types of mobile applications

ColdFusion Mobile Platform allows you to create 3 types of mobile applications:

® Type 1-HTML5-based standalone app that can be installed on the mobile device as a standalone
application. ColdFusion Builder allows you to build platform-specific mobile applications using Adobe's Phone
Gap build service.

® Type 2 - ColdFusion-deployed web app that can be rendered through the mobile device's web browser.
There is no support for device's native functionalities.

® Type 3 —Hybrid/shell app that can run as a standalone mobile application. This type supports device's
native functionalities.

© 2014 Adobe Systems Incorporated. All rights reserved. 5


https://build.phonegap.com/
https://build.phonegap.com/

Adobe ColdFusion Documentation

Deployment type 3
o Hybrid of 1 and 2 9
(Shell app)
Deployment type 1 Deployment type 2
HTML5-based standalone app CF-deployed web app

: Build Build Build - —

CF Builder CF Builder CF Builder i

i Vi i

L On-demand translation

e
I

Content served by CF Server Mo support for native
Supports native functionalities functionalities

Package

Development tools

PhoneGap

s a2 .=

HTMLS-based standalone app HTMLS5-based standalone app Maobile wab browsers

In the case of Type 1, platform-specific PhoneGap JavaScript file and the supporting native libraries are bundled
with the application. In the case of Type 2, mobile browser or any other web browser can be used to access
ColdFusion applications. In Type 3 (hybrid app or shell app), only the native libraries are bundled. The PhoneGap
JavaScript files and the application content gets served by the ColdFusion server.

You can decide on the type of application based on the application requirements.

Note: You can use the window.ispgbuild property to identify if an application is running as shell application or
packaged application.

Configuring the development environment

Setting up the ColdFusion server

Install ColdFusion Server 11 by following the instructions provided in the installation guide. While installation, you do
not need to configure the server to support mobile applications as the support is available by default.

Setting up ColdFusion Builder

Install ColdFusion Builder by following the instructions provided in the Installing Adobe ColdFusion Builder guide.
Before you start reading this document, read the Using Adobe ColdFusion Builder guide.

Creating a mobile project

Note that ColdFusion Builder has introduced a new 'ColdFusion Mobile Project' type that will help you build and
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package mobile applications. However, you can convert your existing ColdFusion projects to a ColdFusion Mobile
projects automatically. See Migrating existing projects.

To create a ColdFusion Mobile project, perform the following tasks:

1. Click File > New > ColdFusion Mobile Project or Right-click on the Navigator area and click New > ColdFu
sion Mobile Project. You will be asked to select a mobile template. For more information on creating your

own mobile template, read Mobile Templates. To import existing templates, click Import. Note that the mobile
template must conform to the standards outlined in Mobile Templates.

New ColdFusion Mobile Project

Templates

Select a Template and respective Type

Templates Type
4 System Templates JQuery Mobile
ELAMK
Master-Detail Description

4 User Templates This template provides a starting point for

Sample Template a master-detail application. It provides a
user interface configured with a navigation
controller to display a list of iterns, User
interface will be created using JQuery
Mobile.

Irmport User Temnplates

J?,"\ L
CJ < Back Mext = Finizsh

2. Click Next.

3. In the Project Information section, enter the following details:
a. Enter the name of your project.
b. Select the CFML Dictionary Version as ColdFusion 11.

© 2014 Adobe Systems Incorporated. All rights reserved.
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-
[¢f] New ColdFusion Mobile Project

Project Information

Enter the project name.

Project Settings

Project Mame MyMobileProject

Use Default Location

Project Location C:/Users/fjenning/Thunder workspace/MyMobilePro | | Browse...

CFML Dicticnary Version | ColdFusion 11 A

@ <Back || MNet> || nsh || Cancel

e

4. Click Next.

In the Server Details screen, from the Servers dropdown box, and click Add Server.

6. In the Server Settings screen, enter the server details. For more information, read the Using ColdFusion
Builder guide. Click Next.

7. In the Link Folders section, map the specific ColdFusion directories available under the Server's web root to
your project:

o
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.
New ColdFusion Mabile Praject =0

Link Folders
cr |

Default Linked Folder
Set linked folder in which termplate will be created

Create default linked folder

Default folder name WyMobileProject

Additional Source

Use the Link Folder to include the resources outside the project.

Link Path Add
{ MyMaohbileProject ChColdFusionSplendoricfusion\wwwroot\MyMobileProject

Remove

4 (L b

@:‘ Mext = [ Finish J l Cancel
h

8. Click Finish.

You have successfully created a ColdFusion Mobile project. Now you can start building your mobile applications.
Note that at this point, you do not need to configure the project with any PhoneGap settings.

Write some code

Now that you have a mobile project, write some code to capture an image from the device camera:

<cfclientsettings enabl eDevi ceAPI =t r ue>

<cfclient>
<cf set
docunent . get El ement Byl d(' resul t'). i nner HTM_.=docunent . get El enent Byl d(' result').innerH
TM.+"Hello fromcfclient!">
</cfclient>

<div id="result"/>

To know more about writing client-side CFML, see the following sections:

® Client-side CEML (for mobile development)
® Getting Started Examples

Migrating existing projects

© 2014 Adobe Systems Incorporated. All rights reserved.
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You can automatically convert your existing ColdFusion projects to ColdFusion Mobile projects by applying the
ColdFusion Mobile nature as shown in the following screen shot:

. Nawngator - O . L3 index

B MyEostingCFPe==m
8 MyFirstCFMob New l

Ll TestMobileapg Go Into
Open in New Window

Copy

Rename...

Import...
Export...

C. E

Refresh
Close Project
Close Unrelated Projects

References ’
Refactor »
Set URL Prefix

Apply CF nature

~ |

Apply CF Mobile nature

Debug As b
Run As ¥
Team »
Compare With [
Restore from Local History...

Properties

Examples

See Getting Started Examples.

Where to go from here

® | earn the ColdFusion Mobile Functions

® Cleint-side CEML - Before building your ColdFusion-based mobile application, learn the CFML tags and
functions that will enable you to build simple to complex mobile applications.

® Packaging mobile applications — After building your ColdFusion-based mobile application, you can package
the application into platform-specific installers.

© 2014 Adobe Systems Incorporated. All rights reserved. 10


https://wiki/display/coldfusionen/ColdFusion+Mobile+Functions

Adobe ColdFusion Documentation

Debugging Mobile Applications

The ColdFusion Mobile Platform aims at providing a server and development infrastructure that facilitates rapid and
robust mobile application development, debugging, packaging, and deployment. The ColdFusion 11 release
introduced rapid application development through ColdFusion Builder. ColdFusion 11 introduces full-fledged
on-device debugging to quickly debug your ColdFusion-based mobile applications on devices.

o Develop codFusion- I ( e Debug apps using a I 9 Package apps targeting ( e Distribute apps on

based mobile apps nich sal of budt-in lools mahile platforms Googhe Play and Apple App
Siore

&= |Cf

The ColdFusion Builder has introduced a new debug server (agent) that acts as a broker between the IDE and the
device. There will be a two-way communication between the debug agent and the IDE.

« i

The ColdFusion Builder Debug Agent intercepts and processes debug
commands from the IDE and device

The IDE provides the debugging information like breakpoints, step over, step in, step out, and resume to the debug
agent. In return, the debug agent provides information like where the code has paused to the IDE so that the IDE
can show the appropriate source file with the highlighted line. When the device starts executing the code,
communicates with the debug agent to get information on when to stop.

There are different scenarios through which you can debug your applications. ColdFusion Builder supports both
local and remote debugging.

1. You can debug your application running on a browser.

2. You can debug a PhoneGap application running on the device.

3. You can debug a standalone HTML5-based mobile application running on the device.
4. Many developers can connect to a remote ColdFusion Server and debug their projects.

© 2014 Adobe Systems Incorporated. All rights reserved. 11
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Local CF Server

kS
'ﬂ::"

Web Browser Device (PhoneGap) Web Browser and Device (PhoneGap)

In scenario 3, developers cannot debug the same ColdFusion mobile project simultaneously.

Debugging a packaged application

The new ColdFusion Builder enables you to run ColdFusion-based mobile applications interactively by inspecting
the source code during the application execution. If you have already used Eclipse for debugging your applications,
you will find debugging in ColdFusion builder easier.

While debugging your application on the browser or on a device, the following debug actions are supported:

1. You can set breakpoints (you can set handles in your source code specifying where the execution of your
application must stop)

2. You can step in, step out, step over, and resume

3. You can get variables while debugging

4. You can set expressions while debugging

When your application completes loading/execution, you can investigate variables and change their content through
a simple interface.

Verify the debug agent configuration

Before you start debugging your mobile application, verify the IP address and port of the Debug Agent. The IP
address of the Debug Agent is most likely the IP address of your machine. These IP address and the port value will
be automatically configured. To verify or change these values, click Windows > Preferences > ColdFusion >
Client Debug Settings.

© 2014 Adobe Systems Incorporated. All rights reserved. 12
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.
Preferences — | B

type filter text Client Debug/Inspect Settings P .-
> Ant
4 ColdFusion Debug settings

Client Debug/Inspect
Debug Mappings
Debug Settings

Debug Agent IP 1019229232 ~

Debug Agent IP - The IP of the machine running the Debug Agent.This value will be automatically populsted. Ensure that this value is conect

Extensions
PhoneGap Debug Agent Port 7777
> Profiles Debug Agent Port - The port on which the Debug Agent listens for incoming debug requests from the device. This value will be sutomatically populsted. Ensure that this valu is comect
RDS Cenfiguration Debug Agent - It is 8 process which runs inside ColdFusion Builder and assists in CFClient debugging
Server Settings S
nspect settings
Snippets P! 9
» CS5
. General Chrome Path - It i the path of the executable Chrome file.
el Ex : On windows machine if Chrome is installed at location "C:\Program Files (x88)\Google!\Chrome” then the Chrome Path is "C:\Program Files (xB8)\Google|Chrome\Appiicationchrome. exs"
> Help
» HTML

> Install/Update
» Java

> JaveScript

> Log Viewer

» Run/Debug

> Team
» XML Restore Defaults Apply
] »

[l T

®

Setting breakpoints

To set breakpoints in your source code right-click in the small left margin in your source code editor and select Togg
le Breakpoint. Alternatively, you can also double-click on this position to enable or disable breakpoints.

o e —
Bir fdt Hevgeie dagoh Beped e Bedos  Hep
SENA B-0-Q-w|wimitE> L e-fi-4- ol = i |‘ [ Comtrrsmnn [ Cotoitumon Drtmsggeng
- T e b D Sty Cuiped Bl %y Bersigets 5 Dapernssees Y =]
s [ chebmnt_daica_comiey [P Ok [ bt

i OB cickent devce_conlg
& ¥ CF{bek Tieand
B ot Spirrador s hyvsoey mesmrvel DmDires el by i pesbolernonts g fre. a4
oll At belsy goiniest

& el
bt

1 Pl sed sl a7

B Comushe 0 [ Problemt
Y i |3 iy o D R

Note that the breakpoints will not be hit for JavaScript code in your application.

Starting the debugger

You need to start the debugger to start debugging ColdFusion mobile applications. Perform the following tasks:

1. Before you begin, you need to generate the PhoneGap Debug Build if you are planning to debug your
applications on the device. Right click your project and select Generate PhoneGap Debug Build. If you have
not configured your PhoneGap settings, you will be prompted to enter the PhoneGap account settings.

© 2014 Adobe Systems Incorporated. All rights reserved. 13
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Compare With "
Restore from Local History...
Compile and Generate Code
. Generate PhoneGap Build
. Phonegap Debug ] . Generate Debug And Inspect Build

Properties . Generate Debug Build
. Generate Inspect Build
2. Once you generate the PhoneGap build, you need to transfer the binary file to your device and install the

application. For instance, on Android, you transfer the APK file to the device and install the APK file.
3. Start the debugger by clicking the Debug Icon on the menu and selecting Debug As > ColdFusion Client

Applications
-
Debug As » [E] 1 ColdFusion Application
Debug Configurations B 2 ColdFusion Client Applications
Organize Favorites... fclient>
- — <cfscriptd

4. Depending on where you have set the breakpoint, your application may look blank when it starts on your
device:

¥

CF Explorer 2 Refresh

CFClient File Browser

5. At this moment, you can see the control at the breakpoint position in ColdFusion Builder. Continue stepping
over and debug your application.

This action will start the device debugger. If you have not defined any breakpoints, this action will run your
application normally. To debug the application, you need to define breakpoints.

Note: If the code being executed on the browser or the shell application encounters a runtime error, you will see al
error message and the debugger will fail to start.

© 2014 Adobe Systems Incorporated. All rights reserved.
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Viewing variables and evaluating expressions

While the debugging session is on, you can view the variables and evaluate expressions easily. Ensure that you
have activated the ColdFusion Debugging perspective:

1. Click Window > Open Perspective > Other.. and select ColdFusion Debugging:
@ Dpen Peripectivg ! 1 = .ﬁ

[Ef] € eldFusian [defautt)
%+ EoldFusion Debugging|
5 Debug
&] leva
5 b Beowsing
Tad lova Type Hiernecky

Lo Pesgarce

|

=" Team Syncheonizing

0K Canecel

2. Click OK to continue

3. You can start viewing the variables through the following window:
b= Vanables I3 '& Debug Output Buffer L Breakpaints & Expressions

Mame Value
a4 glnhal
o1 1
LR i
& lacal

4. Similarly, you can evaluate expressions:

)= Vaniables ﬁ Diebug Output Buffer | ®a Breakpoints | & Expressions 23
MName WValue

oY axel® error

e Add new expression

Stepping in and out

ColdFusion Builder allows you to control the execution of the application you are debugging through simple code
stepping actions.

© 2014 Adobe Systems Incorporated. All rights reserved.
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i Debug 11 % T T O || viables 5 |G Debug Cutput Buffer| %o Breakpoints| 51’ b
o @ chchient_device_config [CFChent] Plarrse
- clehient_dedice_canfiy

W glotul
a ¥ CFChers Thisad & local
= Cloldfusioniplendon chuscon’wwwroot OnDeviceDebuggng  fieesphores.cfm | nefresh 1 53
w chehent debug preceds
] Flcwand | nts.cfm o] filewgplorer.cfm 11 =0
gurreatPath = thisbath; =
functica clearlist
war list = $".madndiv®).children( ) .remove( s
functica refresh E
w oo | loadList| currentPath) ;
functicn wo =

You can step in, step out, and step over to view values of variables and can evaluate expressions.
Debugging a shell application

Setting breakpoints

To set breakpoints in your source code right-click in the small left margin in your source code editor and select Togg
le Breakpoint. Alternatively, you can also double-click on this position to enable or disable breakpoints.
Note that the breakpoints will not be hit for JavaScript code in your application.

i [t fevgein Sopch fowd e fedes  Hop
Gl &S@ES S-0-G~-w|wimi>>4 it LIl bt [+ |'Ec—h_-[ﬁ_mmmm_
T Dty M7 D e bl T Dot Cutpet Bl % Besipit 81 bperisiont L il -
[ ket oo comtey |CFChant] Mt Vet
i OB cickent dewce_conlg & glebal
# ¥ CF ok Thwnd P
T 0 ekl e fpterdor st wpeoe, wwm o [ ety i e pedielfrments a1 - bele L
all i s ot
[T 58 Cuatn '
T L beere g -
P - " il
Pttt Al )
- b—ll“ TR i Al i
L tesatpat Al dickent
#lee LPiw Ls 0 o ket
. wrltpoutat i i
wlee
o LEwoatpat 1
Piw w2
wribsoatput
whee ifin gu an
wrbtaoatpat
wlie
writpoutput
ifefuer o
“fefeliomt
oL ievee
. -
cofif = Bx 35
B Comasin T | (2 Probloms o
B i, 1. digiy o T B
Wridsbiy Temart lrmert 4:1
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Starting the debugger

You need to start the debugger to start debugging ColdFusion mobile applications. Perform the following tasks:

1. Start the debugger by clicking the Debug Icon on the menu and selecting Debug As > ColdFusion Client

Applications
||"I"|
Debug As k [E] 1 ColdFusion Application
Debug Cenfigurations Bl 2 ColdFusion Client Applications
Organize Favorites... fclient>
— = <cfscripts

2. Invoke the application URL from the device using the ColdFusion Shell application:

T LRI

S0 TR el B i g i T ian g

B0, 1 I 2 A SO i T n

i

Higo Meresgabor Hor

ARG T 0 i of
rdrregaiiosm bar, teen you will ot be
mhds 0 coene Dack o this paege. You
will hawve o ol fhe applicsion io
aal Bachk IS ek pEga

3. Depending on where you have set the breakpoint, your application may look blank when it starts on your
device:

© 2014 Adobe Systems Incorporated. All rights reserved.
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CF Explorer

CFClient File Browser

4. At this moment, you can see the control at the breakpoint position in ColdFusion Builder. Continue stepping
over and debug your application.

This action will start the device debugger. If you have not defined any breakpoints, this action will run your
application normally. To debug the application, you need to define breakpoints.

Note: If the code being executed on the browser or the shell application encounters a runtime error, you will see an
error message and the debugger will fail to start.

Viewing variables and evaluating expressions

While the debugging session is on, you can view the variables and evaluate expressions easily. Ensure that you
have activated the ColdFusion Debugging perspective:

1. Click Window > Open Perspective > Other.. and select ColdFusion Debugging:
[E] Open Perspective ==

[l CetdFusion [defat)

i3 ColdFusion Debugging|

#F Debug

&' lrer

5 b Beowaing

ol lova Type Hieraeeky
Fespurce

&7 Team Synchronizang

0K Cancel

2. Click OK to continue
3. You can start viewing the variables through the following window:

© 2014 Adobe Systems Incorporated. All rights reserved. 18
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e Variables 7 | G Debug Output Buffer| ® Breakpoints | 5 Expressions

Mame Value
a4 W glnhal
&1 1
& x ]
& local

4. Similarly, you can evaluate expressions:

)= Vanables Ha, Debug Output Buffer | g Breakpoints | & Expressions &
MName Value

Y "xel” errer

wp Add new expression

Stepping in and out

ColdFusion Builder allows you to control the execution of the application you are debugging through simple code
stepping actions.

% Debusg b 0 ||t Vrisbles 7 |G Debusg Crutput Buffer| % Breskpoints| 57 b
o @l cfchent_device_config [CFChent] Marrs
a 7% cichent_device_ confiy & global

a@ ® CFCherd Thigad
= C\ColdfusionSplendon cusenwawwrocti OnDeviceDebisgging' leesplores.cfm 1 nefrech 153
wal elehent debug preceis

& ool

)] Fiowandoondutstemsents.cfm ] fileaqplcrer.cfm

currentPfath = thiiPath;

s clearlist
war lisk = § adinaili «children| ) .remowvel 1

o refresh

L] | loadLisk currentPath);

=_we

You can step in, step out, and step over to view values of variables and can evaluate expressions.

Troubleshooting tip

Note that on Linux, if the debug agent port is not open by default, you should manually go and enable traffic on that
port through your Linux tools/firewalls (iptables). For more information on opening up ports on your machine, read
the manual for your Linux distribution.

For more information on using the debugger user interface in ColdFusion Builder, see the Eclipse help.

© 2014 Adobe Systems Incorporated. All rights reserved. 19
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Community videos
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Inspecting Mobile Applications

Step 1 — Start the local Weinre Server

Step 2 — (Optional, if not Step 1) Provide the remote Weinre Server location
Step 3 — Configure ColdFusion Builder

Step 4 — Packaging the mobile application

Step 5 — Inspecting the mobile application

Inspecting web-based mobile application

Weinre (Web Inspector Remote) is a remote inspector that can be used to debug your HTML-based mobile
applications generated by ColdFusion. If you have already used PhoneGap for building applications and Weinre for
debugging applications, you will find the Weinre support in ColdFusion very easy to use.

The following illustration depicts how you can inspect and control your mobile applications through the Weinre client:

@ Use CF Server to translate CFML to HTML
% CF Server injects the Weinre Server
details into HTML

3 ~ Use CF Builder to create PhoneGap
builds for specific devices

Use CF Builder to code in GFML

Install the PhoneGap application on
device

S qmim Server
Start inspecting
Weinre Client (H

Let us assume that you are packaging your ColdFusion-based mobile application into a platform-specific build
targeting a particular device. You need to follow these broader steps to successfully inspect your application
installed on the device:

1. Use ColdFusion Builder to develop the application. See Building mobile applications.
2. Start the local Weinre Server from the ColdFusion Server Administration Console. See Step 1 — Start the
local Weinre Server. You will get the Weinre client URL when the Weinre Server starts.
3. Configure ColdFusion Builder with Weinre Server IP address and port details. See Step 3 — Configure
ColdFusion Builder.
4. When you create a PhoneGap application:
a. The ColdFusion Server translates the CFML files to equivalent HTML and JavaScript files.
b. The ColdFusion Server also injects code into the HTML files allowing the HTML files to be inspected
remotely through the Weinre Client running on a browser.
Copy and install the PhoneGap application on the device.
Open the application on device.
From a remote browser, access the Weinre client through the URL obtained from step 2.
Start inspecting the application from the browser.

-~ D 2 0
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The following section describes these steps in detail.

© Note: A Weinre inspection server is bundled with the ColdFusion Server. All that you need to do
is start the local Weinre Server and start remotely inspecting your applications installed on
devices.

Step 1 — Start the local Weinre Server

To start the local Weinre Server, perform the following tasks:

1. In the ColdFusion Administration Console, click Debugging & Logging > Remote Inspection Settings
2. On the right panel, click Allow Remote Inspection

3. Click Local Weinre Server

4. Leave the default values for the IP address and port

5. Click Start Weinre Server

cf Adobe ColdFusion 10
Solr Server Click the button on the ight to update Weinre Settings
< Integration Remote Inspection Settings > Weinre Settings
PDOF Serace
* DEBUGGING L LOGGING Remote DOM Inspection Settings
Debug Oulput Settings 7 Allow R I i
Debuggng IP Addresses
Debugger Sethings @ Local Weinte Server
Loggung Sethings Remote Weinre Server
-0g ies . Weinre Server Setings
System Probes
Code Analyzer : Select the local IP Address 127001 v
@ Scannes Port 000
Remote Inspection

F SERVER MONITORING

P EXTENSIONS
Click the button on the nght to update Weinre Settings

P EVENT GATEVERY S

e L.

6. When the Weinre Server gets successfully started, you can see a message containing the Weinre client URL:

[t weev sanwr J Restarworve sever

To access weinre client go to this wrl:

Step 2 — (Optional, if not Step 1) Provide the remote Weinre Server location

To configure a remote Weinre Server, perform the following tasks:

1. In the ColdFusion Administration Console, click Debugging & Logging > Remote Inspection Settings
2. On the right panel, click Allow Remote Inspection
3. Click Remote Weinre Server
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4. Enter the Weinre server URL
5. Click Submit Changes

® ® ® | Locour

Selr Server Chck th butlon on th nght 1o update Wiesnes Seftngs
Flox it steon Remote Inspection Settings > Weinre Settings

Femcte [FOM Inspection Seftings
+ Allcwr Remobe Inspection

Local Weinie Served
#* Remote Weinie Server

- e Saivel hap [fdebug phonegap com

sche Anadyter I Locathon
Homote lnupecton .
Settings Chck the bution on Ihe nght 1o updale Weswve Seftangs

VIR R el L

Step 3 — Configure ColdFusion Builder

When you have a local Weinre Server running, right-click the ColdFusion Mobile project, select Properties >
ColdFusion Mobile Project and click the Inspect tab. Enter the Weinre Server URL. If a local Weinre Server is
running provide the loopback address. You can provide a unique ID/GUID that will identify your debug sessions in
the Weinre Server.

[ Properties for MyFirstCFMobile W T (e e

type filter text ColdFusion Mobile Project = A
»+ Resource -
Builders | Resource Selection | PhoneGap | Centificates | Inspect | Miscellaneous | =
CFC Mappings Wenre Server URL - The URL of the server where the Weinre server is hosted. This value c2

ColdFusion Mobile Project GUID - The unique identifier for each user if multiple users are using the same VWeinre server. |
ColdFusion Project E

. . Wei fi i
ColdFusion Server Settings einre Server Configuration
Project References Weinre Server URL  http://127.0.0.1:5000

Run/Debug Settings

GUID frank]

Access Weinre chent at; hitp:127.0.0.1:9000/chent/#frankj

@ [ ok || Cancel

Step 4 — Packaging the mobile application

See this section.

Step 5 — Inspecting the mobile application

© 2014 Adobe Systems Incorporated. All rights reserved.
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You need to connect the mobile device to the same network as your Weinre Server. When the application is running
on your device, open a remote browser and type the URL of the Weinre client that you have obtained in Step 1.

Targets

Chents

Server Properes
m———y

You will see the Weinre client interface. The Targets section lists the applications running on all connected devices

available for inspection. When the hyperlink is green, the application is ready for inspection. Click the link to see the
source code of the running application:

Start inspecting your application. For more information on the Weinre user interface, see this web page.

Inspecting web-based maobile application
For a web-based mobile application (not a packaged PhoneGap build), the steps mentioned above are applicable

except for a few minor changes. The mobile will request for a web page with a query parameter of INSPECT in the
URL. You can manually provide the URL parameters as follows:
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® http://<ip address>:<port>/<file path>?INSPECT
® http:// <ip address>:<port>/<file path>?INSPECT&GUID=weinre
® http:// <ip address>:<port>/<file path>?INSPECT=false

© Note that in the case of static files, Weinre inspection will work only if these files are served by
the ColdFusion Server. If the static files are served from any other server like Apache or IS
server, the inspection may not work.

© 2014 Adobe Systems Incorporated. All rights reserved.
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Packaging Mobile Applications

® Qverview
® Supported mobile platforms
® Packaging applications using ColdFusion Builder
® Global configuration requirements
® Step 1 — Get the required certificates
®* Step 2 — Register for a PhoneGap plan
® Step 3 — Provide the server and authentication details

® Project-specific configuration requirements
® Step 1 Configuring the mobile project properties
® Step 2 Invoking the PhoneGap build service

® Testing the mobile application
® On Android
®* OnioOS

® | oading Hybrid applications (Type 3)
® References

Overview

Once you are done building the mobile application, you can package the application targeting some common mobile
platforms. ColdFusion builder packaged applications can access the native capabilities of the mobile platform.
When you are building the applications, you will be writing only CFML code and not any device-specific native code.

Ideally, you will be using ColdFusion Builder for building the mobile application and ColdFusion Server for translating
the ColdFusion code in your application to corresponding HTML/JavaScript code that can be packaged and installed
on the device. ColdFusion builder gets this translation done through ColdFusion Server seamlessly with a few easy
configuration settings. ColdFusion Builder helps in creating platform-specific installers (.apk and .ipa) by invoking the
PhoneGap build service. However, you do not need to package the application targeting individual platforms if you
are not using any hardware or device-specific functionalities.

See Types of mobile applications for all the supported types while building ColdFusion-based mobile applications.
Information available in this chapter is only applicable for Type 1 and Type 3 deployments.

Supported mobile platforms

The ColdFusion builder currently supports packaging applications for the following mobile platforms:

® Android 4.x or higher
® iOS 6.0 or higher

Note that the platform requirements are enforced by the PhoneGap build service and not by ColdFusion Builder.

Packaging applications using ColdFusion Builder

After creating your mobile application in ColdFusion Builder, you can generate a platform-specific package that can
be installed on the mobile device (iOS and Android). ColdFusion Builder sends the ColdFusion (.cfm) files to the
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ColdFusion Server, which converts the .cfm files to .html and .js files. All these files along with a generated
PhoneGap configuration file (config.xml) are bundled and submitted to the Adobe’s PhoneGap build service. When
the PhoneGap build service completes the build process, you can download the builds to the local file system.

9'.‘Z'.-«:|I|‘.|Fu:|-:|n Builder uses the
publicly available PhoneGap
buld senice o generabs
platiomme-specific bulds

ColdFusion Builder uses
thr ColdFusion Server o

translate the CFM files o \\
HTRL filos "

Global configuration requirements

The following sections describe the global configurations required to prepare ColdFusion Builder for creating
platform-specific mobile applications.

Step 1 — Get the required certificates

The ColdFusion Builder supports creating platform-specific builds for Android and iOS platforms. In order to package
the mobile applications for these platforms, you need to configure the ColdFusion Builder to sign the applications
with an appropriate developer/self-signed certificate. In the case of Android, providing the certificate details is
optional as you can create an Android Application Package (APK) file for testing on your devices without signing it.
However, testing the mobile application on iOS devices require you to have a developer certificate and a
provisioning profile file.

Ensure that you follow the steps provided in this article to get started:

For iOS development

® Create and download development provisioning profiles. Note that you need to first join the iOS developer
program to generate developer certificate for testing your mobile applications.

For Android development

® Create the keystore file for signing applications.

Step 2 — Register for a PhoneGap plan

You need to register on the PhoneGap build service site and get a suitable PhoneGap build plan. Choose from the a
vailable plans here and complete the registration. You can either register and create a new account or you can login
using your Adobe ID.
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Step 3 — Provide the server and authentication details

Once you have created and stored the required certificates, go to Windows > Preferences > ColdFusion >
PhoneGap and provide the required details as shown in the following screen:

[£7] Preferences | &
type fitber text PhoneGap = * w
4 Adobe ) ]
RDS Configuration Compilation Settings
Ant Server URIL: build.phonegap.com
Clierit Debug Settings
4 ColdFusion Email Address:  flenning@adobe.com
Debug Ma.p.upmgs Password : sessnsas
Debug Settings
Editor
PhoneGap 05 key details
Server Settings 06 Certificate(pl2): fidevcert.pl2 [ B |
Snippets 105 Certificate(pl?) : fidewcert.p | owse. |
General Provisioning profile:  fidev.developerprofile I Browse... |
Help : .
HTML Certificate password:  ssssssns
Install/Update Title:  Fi0S Develaper Certificate
Java
Javasenpt
Run/Debug Android key details
Team - 1
Joeystore fille:  fjdebug. keystore Browse... |
Title: FJ Android Keystore file
Aligs:  fjdebug
Key password: ssssssss
Keystore password : ssssssss
:hﬂumﬂ:ﬁuh_ | Apphy
@ oK | Cancel

©® Important
Note: If any of the iOS key details are not specified, packaging will not work. Ensure that you
specify ALL the details.

Project-specific configuration requirements

The following sections describe the project-specific configurations required to prepare ColdFusion Builder for
creating platform-specific mobile applications.

Step 1 Configuring the mobile project properties

1. If you have already created a ColdFusion Builder Mobile project (see Building Mobile Applications), right-click
the project in the Navigator panel and click Properties.

2. Select the ColdFusion Mobile Project in the left pane to see the available properties for configuration.
Note: For packaging Server CFCs, go to the Miscellaneous tab and provide the application base URL.

3. In the ColdFusion Mobile Project panel, select the Resource Selection tab and ensure that only the CFM
files and other supporting assets (under the Server's web root directory) are selected:

© 2014 Adobe Systems Incorporated. All rights reserved. 28



Adobe ColdFusion Documentation

Properties for MyFirstCFMobile d il - | (e |
type filter text ColdFusion Mobile Project hd A
» Resource
Builders Resource Selection | PhoneGap | Inspect | Miscellaneous
CFC Mappings Select the files that have te be part of the build.
ColdFusion Mobile Project
= § MyFirstCFMobile [ indexctm

ColdFusion Project
ColdFusion Server Settings
Project References
Run/Debug Settings

Restore Defaults
@

Keep your CFM files and other supporting assets in a separate directory under the web root directory so that
you can select just that directory.
Important: All the selected files must be present under the Server’s web root directory or under web root’s
sub-directories. Also, it is mandatory to have an index.cfm file in your application. PhoneGap mandates its
index file to be present in the root folder, because of which ColdFusion has to mandate all the mobile
applications developed by ColdFusion Builder should have the index.cfm or index.html in the
application root folder.

4. Select the PhoneGap tab.

y i —— - - T —_— " - 28—
Properties for MyFirstCFMobile . | ol

type filter text ColdFusion Mobile Project T

+ Resource
Builders Resource Selection | PhoneGap || Inspect | Miscellaneous

CFC Mappings

Cu\dFusiun Mu.b\\EPruje:t Configuration Value
ColdFusion Praject :
ColdFusion Server Settings 4 widget
Project References xmins hittpe/fwww.w3.org/ nsfwidgets
Run/Debug Settings xminsigap hitp//phonegap.com/ns/10
id app.coldfusion.com
version 100
name MyFirstCFMobile
description Application Developed By ColdFusion B...
4 author
name
email
href

4 preference
phonegap-version 2,50
orientation default
target-device universal
fullscreen true
webviewbounce true
android-installLocatior intemalOnly
splash-screen-duration 5000
Ioad-url-timeout 20000

[] Load the configuration from XML

<onfiguml: Browse...

Restore Defaults Apply
®

All these properties are automatically populated by ColdFusion Builder. You just need to change the
author-specific information. Alternatively, you can also load the PhoneGap settings from an external
PhoneGap configuration file. See https://build.phonegap.com/docs/config-xml for a sample PhoneGap
configuration. If you need to add any other platform-specific attributes, you can add them through by clicking
the Add Attribute... button. Note that there major changes from PhoneGap version 2.9 to 3.x. If you want to
manually specify a PhoneGap version, you need to understand the changes mentioned in this document.

5. Also, you need to link the web root path to your project. Click ColdFusion Project > Add to map the
ColdFusion Server web root directory to a linked alias:
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[E1] Pregertass for TestMebi — e e [
type filter bt ColdFusion Project - T v w
# Resource

Lo Fisbenirsist Froject Settings
Resourcs Filen Project Mame
Builders
CFC Happlngi. Preject Locatasn
ColdFuion Mokbile Project
ColdFumen Project CFML Decticnary Viersion | ColdPusion 11 -
ColdFumion Server Settings
Progect References Addrticasl Souice
Ref sctoning Higtoy s Link Foider bo molude resoerces oubsioe the progect
Run/Debug Seitings
Link Path Add
et pot o\ oldFusionSplendor dusion'wawroot
M
Start Page Setting
Use Start Page
Stant Page:
s Exténdicn

Retore Dd'll.d‘h._ [ Apphy

Step 2 Invoking the PhoneGap build service

After you have configured the mobile project with PhoneGap build service settings, you can invoke the PhoneGap
build service, by right-clicking the mobile project and by clicking Generate PhoneGap Build. You may need to wait
for a few seconds to obtain the platform builds from the PhoneGap service.

If you have triggered multiple builds, you can quickly check the status of your builds by invoking the PhoneGap
build status view by clicking Window > Show View > Other > ColdFusion > PhoneGap Status.

[] Snippets = Progress o]
S{.r{lng PhoneGap Buld

= -
Tryang to suthentscate agamnst PhoneGap server.. Executing busld on ColdFuison Server

Note that you need to add the PhoneGap Status view to the ColdFusion perspective.

You can also log into the PhoneGap build service site and check the progress of your builds:

1. Go to https://build.phonegap.com/
2. Click Sign in
3. Click Apps and check the progress of the builds
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@ Hello World

If there are no errors while generating the platform-specific builds, you will see the download buttons for
downloading the builds from the PhoneGap build server.

Editor

CF Servers | Bl Console | T Problems | ) PhoneGap Status 52| & ~ = O

Application Name App Id 105 Build Status Android Build Status Delete

i Phonegap App 340850 Download :annlnad] |Delete]

When you click the Download button, the build will get downloaded and stored in the PhonegapApps directory
under the ColdFusion Builder workspace and you will get a notification message as shown in the following figure:

@ Successfully downloaded the application ﬁ

ChUsers\fjenning\Adobe ColdFusion Builder workspace\PhonegapApps\Phonegap
App_ 0830 apk

Testing the mobile application

Now that you have generated the platform-specific builds, you can test them on your mobile device to ensure that
the application is functioning properly.

On Android

To test the application on an Android device, perform the following tasks:

1. Transfer the APK file to the SD card or the phone memory.
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ol 803

Phonegap
App_3408..

B i ==

2. Execute the APK file to start the installation

ma b b L S

Allow this applic

« Your location

« Your personal infermation

« MNetwork communication

l Install u Carece: J

3. Once installed, invoke the application from the Applications menu:

Helix World

Note that you need to enable your Android device to install non-market applications. See the troubleshooting section
on installing non-market applications.

On iOS
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When you have an IPA file stored locally, you can use Apple iTunes software to install the application on your iOS
device.

To install the test application on your device, perform the following tasks:

1. Inthe Finder, drag the provisioning profile (the file with the . nobi | epr ovi si on extension) to the iTunes
icon in the Dock.

2. Double-click the app archive <App_Nane>. i pa. The app appears in the iTunes Applications list.

3. Sync your device. If the version of iOS on your device is earlier than the test application can run on, you need
to update your device with the current version of iOS.

See this video to understand how IPA files can be installed on devices using Apple iTunes. Ensure that the test
device is provisioned before installing the IPA file. See this document to understand device provisioning.

Loading Hybrid applications (Type 3)

You can use the PhoneGap Shell Application (available for download from the pre-release forum) to load hybrid
applications on your mobile device.

To build a hybrid application, develop a ColdFusion Mobile application in ColdFusion Builder and deploy the
application on ColdFusion Server. You need to include the /CFIDE/cfclient/useragent.cfm file that will allow your
application to detect the mobile platform and will correspondingly load the platform-specific (Android or iOS)
Cordova JavaScript file at runtime.

You can then run the mobile application deployed on the ColdFusion Server by entering the URL in the PhoneGap
Shell Application or from your own customized shell application.

When the hybrid application is invoked, the content gets loaded from the ColdFusion Server. Also, the
platform-specific Cordova-*.js file gets served by the ColdFusion Server depending on the mobile platform.

Use the PhoneGap Shell Application while developing your ColdFusion Mobile project to quickly test the application.

References
® Understand the PhoneGap build configuration
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Troubleshooting Mobile Applications

Installing non-market applications
PhoneGap application limit

Error while building iOS bundle
Cannot install the IPA file

The following sections discuss some of the common errors that may occur when you are developing, packaging, or
deploying mobile applications.

Installing non-market applications

While installing your mobile application on an Android device, if you are getting the following security error, you need
to enable the installation of non-market applications on your device.

Imstall blocked

ity, your phone is set

cangel

Click the Setting button, and go to the appropriate screen where you can enable installing non-market applications
(from unknown sources):

- il 923 am
Applications

Unknown sowrces

Manage applications

Runni Ng Senices

Storage use

Note: The settings menu and the Ul labels may differ depending on the version of Android.

PhoneGap application limit

In order to create new private applications using PhoneGap, you need to upgrade your subscription to a paid plan
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(up to 25 private applications). To upgrade your account, go to https://build.phonegap.com/plans and click on the
green $9.99 paid plan button at bottom right to proceed through the registration process.

Note that the free plan allows only 1 private application. So, if you are creating more than one application, you will
get the following error in ColdFusion builder:

r B
Error ﬁ

0 The PhoneGap Build Server reported the following error “Private app limit reached”

When this error occurs, you can either delete the existing private application or migrate to a paid PhoneGap plan.

Error while building iOS bundle

When you do not specify the right credentials for iOS packaging, PhoneGap build service will fail to produce the
required IPA file:

Y ———————— =)
fle 42 fow Moy Becbmats Jooh Hep |

I8 Aidcbe Phoratiap Bodd [+

& a phonegeziam * H- P o#

Phonegap App

3

;

-

g - Prcrglany et Lt | 21 Yoarra

05 Mo key selecned f= o Mo key selected o m
- o= Tl = o - o= D
o [ENM o X

Ensure that you have specified the path to the iOS developer certificate and the provisioning profile from the
ColdFusion Builder. See Global configuration requirements.

Cannot install the IPA file

If you cannot install the IPA file on the device using Apple iTunes, check if the device is provisioned through the iOS
provisioning portal. See this document for more information.
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Device Detection

Detecting the device characteristics
Supported device detection features
Using media queries

Handling orientation changes
Handling window resizing events
Setting device timeout

Detecting the device characteristics

The device detection feature of CFML allows you to identify the device properties and characteristics, which can be

used to determine the best content, layout, mark-up or application to serve to the given device.

These characteristics include screen size, browser type and version, media support, and the level of support for
CSS, HTML, and JavaScript.

For getting the device features and capabilities, you need to specify an attribute detectDevice in the
<cfclientsettings> tag and set it to true:

.....................................................................................................................................................................................

If the detectDevice attribute is set to true, ColdFusion automatically detects the features and capabilities of the
device (width, height, and orientation) on which the application is running.

Note: If detectDevice is set to false, all <div> elements need to be defined before the <cfclient> block.

Supported device detection features

The following example shows the usage of the device detection feature:

© 2014 Adobe Systems Incorporated. All rights reserved.
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<cfCientSettings detectDevice=true />

<cfclient>

<cffunction access="public"

<cf set

name="showcanvassupport" returntype="void" >

docunent . get El ement Byl d(' canvas').i nner HTM.=cf cl i ent. properti es. canvas>

</ cffunction>

</cfclient>

Canvas support

-<b id="canvas" ></ b><br>

<but t on onclick="i nvokeCFC i ent Functi on(' showcanvassupport',null)">

Show canvas support

</ button>

In the above example, we are trying to find if the device supports HTML5 Canvas. cfclient.properties.canvas returns
a boolean value indicating the support for the HTML5 Canvas property.

ColdFusion Server internally uses Modernizer JavaScript library (version 2.6.2) for the device detection feature.

The following table lists the supported device features with example usage:

Features

Touch Events
Canvas Text
Canvas
Geolocation

Web Sockets
Drag ‘n Drop
History
applicationCache
localStorage

Width

© 2014 Adobe Systems Incorporated. All rights reserved.

Syntax

cfclient.properties.touch
cfclient.properties.canvastext
cfclient.properties.canvas
cfclient.properties.geolocation
cfclient.properties.websockets
cfclient.properties.draganddrop
cfclient.properties.history
cfclient.properties.applicationcache
cfclient.properties.localstorage

cfclient.properties.width
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Height

Device Width

Device Height

Orientation

Device Group Name

Device Group Descriptions

CSS Animations

CSS Columns

CSS Generated Content

CSS Gradients

CSS Reflections

CSS 2D Transforms

CSS 3D Transforms

CSS Transitions

Audio

Video

Hash Change

IndexedDB

Input Attributes

Input Types

Post Message

Session Storage
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cfclient.properties.height

cfclient.properties.deviceWidth

cfclient.properties.deviceHeight

cfclient.properties.orientation

cfclient.properties.deviceGroupName

cfclient.properties.deviceGroupDescription

cfclient.properties.cssanimations

cfclient.properties.csscolumns

Cfclient.properties.generatedcontent

cfclient.properties.cssgradients

cfclient.properties.cssreflections

cfclient.properties.csstransforms

cfclient.properties.csstransforms3d

cfclient.properties.csstransitions

cfclient.properties.audio

cfclient.properties.video

cfclient.properties.hashchange

cfclient.properties.indexeddb

cfclient.properties.input.* (* refers to attributes for input
elements. For possible values, see the Modernizr
documentation)

cfclient.properties.inputtypes.* (* refers to input type
attributes. For possible values, see the Modernizr
documentation)

cfclient.properties.postmessage

cfclient.properties.sessionstorage

39



Adobe ColdFusion Documentation

Web Workers cfclient.properties.webworkers

Web SQL Database cfclient.properties.websgldatabase

For the description on all above mentioned features, see the Modernizr documentation.

Using media queries

Media queries allow you to apply changes to the page design based on the viewing size and capability of the device
on which your content is displayed. A media query consists of one or more logical expressions formed using the
detected device data that checks for certain conditions of media feature and based on the result of this expression
we can change the layout of the page dynamically.

If you are building a mobile application, you can easily detect the characteristics of the device and customize the
layout just for that device as shown in the following example:

<cfclientsettings detectDevice=true />
<cfclient>
<cfif cfclient.properties.width Ite 480 >
<cfinclude tenpl ate=" phone.css ">

<cfelseif cfclient.properties.width gte 480 AND
cfclient.properties.width Ite
760>
<cfinclude tenplate=" tablet.css ">

<cfel se>
<cfinclude tenpl ate=" desktop.css ">

</cfif>
</cfclient>

In the above example, the web page is customized for different devices based on their screen sizes.

Handling orientation changes

For handling the device orientation changes, you can register a listener using the addOrientationListener() function:
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<cfclientsettings detectDevice=true />
<cfclient>
<cf out put >
Oientation : <b id="orientationld"></b><br>
Wdth : <b id="w dt h"></b><br>
Hei ght : <b id="hei ght"></b><br>
</ cf out put >
<l--- Adding the orientation handler here. After adding
the handl er, the handler will be invoked whenever there
is an orientation change. --->

<cfset cfclient.addOrientationListener(orientationHandl er)>

<cffunction access="public" name="orientationHandl er"
returntype="void" >

<cfargunent nane="orientationString" type="string">
<l--- The orientation (landscape/portrait) wll be
passed as an argunent to the handler. You can al so get
the orientation value fromcfclient. --->

</ cffunction>

</cfclient>

In the above example, addOrientationListener function is used to register a listener that monitors the orientation of
the device (landscape or portrait). When the orientation of the device changes, an orientationHandler call back
function is invoked.

You can use the removeOrientationListener to un-register the listener:

<cffunction access="public" nane="renoveorientationhandl er”
returntype="void" >
<cfset cfclient.renoveOrientationListener(orientationhandler)>

</ cffunction>

<cfset cfclient.addOrientationListener(orientationHandlerl)>
<cfset cfclient.addOrientationListener(orientationHandl er?2)>

When the device orientation changes, all the registered listener functions are invoked.

Handling window resizing events

For handling the window resizing events, you can register a listener using the addResizeListener() function:
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<cfclientsettings detectDevice=true />
<cfclient>
<cf out put >
Wdth :<b id="w dth"></b><br >
Hei ght :<b id="hei ght"></b><br>
Device width :<b id="devi cew dt h"></b><br >
Devi ce hei ght :<b id="devicehei ght"></b><br>
</ cf out put >
<l--- Adding the resize handl er here.
After adding the handler, the handler will be
i nvoked whenever there is a browser
resize. --->

<cfset cfclient.addResizeli stener(resizehandl er)>

<cffunction access="public" nane="resizehandl er"
returntype="void" >
<cfargunent nanme="w dth" type="string">
<cfargunment nanme="hei ght" type="string">
<cfset docunent. get El ement Byl d(' wi dth').inner HTM.=wi dt h>
<cfset docunent. get El enent Byl d(' hei ght"').i nner HTM_.=hei ght >
<cf set

docunent . get El ement Byl d(' devi cewi dth' ). i nner HTM_=cfcl i ent. properti es. devi ceW dt h>
<cf set

docunent . get El ement Byl d(' devi cehei ght').inner HTM.=cfcl i ent. properti es. devi ceHei ght >
</ cffunction>
</cfclient>

.....................................................................................................................................................................................

<cfset cfclient.addResizeli stener(resizeHandl er1)>
<cfset cfclient.addResizelListener(resizeHandl er2)>

When there is a change in window size all the registered resize listener functions are invoked. You can use
removeResizeListener() to un-register the handlers.

.....................................................................................................................................................................................

<cffunction access="public" name="renoveresi zehandl er"
returntype="void" >

<cfset cfclient.renoveResizelistener(resizeHandler)>
</ cffunction>

Setting device timeout
In the <cfclientsettings> tag, an attribute called deviceTimeOut can be specified. The default value of deviceTimeout

is 10 secs. When enableDeviceApi or detectDevice is set as true, the deviceTimeOut value will be honored. Time
will be provided for the required plugins to be loaded. After the specified time, an exception will be thrown.
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<cfclientsettings detectDevice=true
devi ceTi neQut =" 30" />
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Client-side CFML

See Client-side CEML (for mobile development).
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Mobile Templates

ColdFusion Builder allows you to create a mobile application based on pre-defined templates. These templates are
basically CFML files that can use third-party web frameworks like Bootstrap or jQuery Mobile. ColdFusion Mobile
Templates enhance productivity, allowing few of your developers to focus on the design of your applications, while
the other developers can focus on the functionality of the applications.

ColdFusion Builder supports 2 kinds of mobile templates:
1. System templates - The bundled mobile templates.
2. User templates - The templates created by you.

Structure of mobile templates

Your mobiles templates can be in a custom directory or an archive (.zip) file. User defined templates should be
stored in <cfbuilder install>/templates/mobile/user. If you want to create your own mobile template, you need to have
the following mandatory items in your template directory:

® config.xml - The configuration file for your template.
® <your_template_dir> - The directory containing the template files.

Note the following requirements:

1. You can provide a template name in the config.xml file as follows:

<tenpl ate nanme="My Tenpl ate">

If you do not provide a template name, the folder name or the archive (.zip) file name will be used.

2. Description can be provided in the configuration file:

<descri ption>
The tenpl ate description
</ descri ption>

3. You MUST specify one or more types in your template. Types are logical grouping of your templates. For
instance, all jQuery Mobile based templates can be named as 'jQueryTemplates'. In this case, you need to
have a corresponding directory, 'jJQueryTemplates' at teh same level as config.xml file.

An example configuration file

The following example shows a valid configuration file, config.xml:
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<tenpl ate name="My Tenpl ate">
<descri pti on>
The tenpl ate description
</ description>
<types>
<type val ue="j Query" >
<descri ption>
My nobile tenplate containing jQery Mbile files.
</ description>
</type>
<type val ue="j avascript" />
<type val ue="boot strap">
<descri ption>
My nobile tenplate containing Bootstrap files.
</ descripti on>
</type>
</types>
</tenpl ate>

For using the mobile templates, see Building Mobile Applications.

© 2014 Adobe Systems Incorporated. All rights reserved.

46



Adobe ColdFusion Documentation

Getting Started Examples

A simple example

Building mobile applications using the ColdFusion Mobile Platform is easy. Your code will be as simple as:

.....................................................................................................................................................................................

<cfclient>
<cfset myvar = "Hello World">
<cf out put >#nyvar #</ cf out put >
</cfclient>

Note the new ColdFusion tag, <cfclient> that will be used for mobile development (see The new <cfclient> tag). The

ColdFusion content available in the <cfclient> block gets translated into corresponding HTML/JavaScript content.

A more complex example

Let us launch the device camera:

.....................................................................................................................................................................................

<cfclient>
<cfscript>

function | aunchCanera()

{

/1 Capture the image fromthe device conera

var opt = cfclient.canera.getOptions();

var resp = cfclient.canera.getPicture(opt);

var fileContent = cfclient.file.readFil eURl AsBase64(resp);
/1 Process the image

return;

}

</ cfscript>
</cfclient>

Examples

Using the Accelerometer APIs
Using the Audio capture APIs
Using the Camera APIs

Using the Connection APIs
Using the Contact APIs

Using the Event API

Using the File APIs

Using the Geolocation APls
Using the Storage APls

Using the Video capture APIs
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Community posts and tutorials

Creating database mobile application with ColdFusion Splendor
Simplify Mobile Application Development Using ColdFusion
Using Geolocation APIs in ColdFusion Splendor

Taking picture and uploading to ColdFusion server

Accessing remote data from mobile applications
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Using the Accelerometer APIs

Before you begin, see Accelerometer Functions.

Setting Accelerometer options

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cfset res = cfclient.accel eroneter. get Opti ons()>
<cfset res.frequency=20000>
<cfset cfclient.accel erometer.setOptions(res)>

</cfclient>

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cfset opt=cfclient.accel eroneter.getOptions()>

<l--- Assuming a <div> elenent is defined with id "result"--->

<cfset document.getEl ementByld('result').inner HTM.="COpti ons obj ect:
#JSON. stringi fy(opt)#">

<cfset watchld=cfclient.accel eroneter.watch("callbackfunc", opt)>

<cf set

docunent . get El ement Byl d(' resul t'). i nner HTM_.=docunent . get El enent Byl d('result').innerH
TML+"Wat ch | d: #wat chl d#" >

<cffunction access="public" nane="cal | backfunc" returntype="void" >
<cf argument name="accel eration">
<cf set
docunent . get El ement Byl d(' result'). i nner HTM.=docunent . get El enent Byl d('result').innerH
TML+" <br >Val ue from cal | back function">
</ cffunction>

</cfclient>

<div id="result"/>
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Using the Audio capture APIs

Before you begin, see Audio Functions.

A simple example for audio capture

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>

<cfclient>

<cfset opt = cfclient.audio.getOptions()>
<cfset cfclient.audio.capture(opt,'funcl')>

<cffuncti on name="funcl">
<cf argunment nanme="nedi aFi | eArray" >
<cfset docunent.getEl ementByld(' result').inner HTM.="<br >Val ue from
cal | back function">
<cf set
docunent . get El ement Byl d(' resul t').i nner HTM_.=docunent . get El enent Byl d('result').innerH
TML+JSON. st ringi fy(nedi aFi | eArray) >
<cf set
docunent . get El ement Byl d(' result'). i nner HTM.=docunent . get El enent Byl d('result').innerH
TML+nedi aFi | eArray[ 1] . ful | Pat h>
</ cffunction>

</cfclient>
<div id="result"/>

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPI =t r ue>
<cfclient>
<cfset nmediaFileArray=cfclient.audio.capture()>
<cfset medFil =nmedi aFil eArray[1].full Pat h>
<l--- Play the nedia file --->
<cf functi on name="pl ayi ng">
<cfset medObj = cfclient.audio.play(medFil)>
</ cffunction>
<l--- Pause the nedia --->
<cffuncti on name="pausi ng">

<cfset cfclient.audio. pause(nedj)>
</ cffunction>
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<l--- Release the nedia --->
<cffuncti on nane="rel easi ng">

<cfset cfclient.audio.release(nmedj)>
</ cffunction>

<l--- Stop the nedia --->
<cffuncti on name="stoppi ng">

<cfset cfclient.audio.stop(nedj)>
</ cffunction>

<l--- Get current position of the nedia file --->
<cffuncti on nanme="get cur pos" >

<cfset pos = cfclient.audio.getCurrentPosition(nmeddj)>
</ cffunction>

<l--- Goto a position in the nedia file --->
<cffunction name="seeki ngto">
<cftry>

<cfset pos = cfclient.audio.seekTo(nmedj, 2)>
<cfcatch type="any">
<cfset alert(cfcatch. message)>
</ cfcatch>
</cftry>
</ cffunction>

<l--- Start recording --->
<cffunction name="rec">
<cftry>

<cfset pos = cfclient.audio.record(nedj)>
<cfcatch type="any">
<cfset alert(cfcatch. nessage)>
</ cfcat ch>
</cftry>
</ cffunction>

<cffunction name="stoprec">
<cfset cfclient.audio.stopRecordi ng(nmedoj) >
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</ cffunction>

</cfclient>
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Using the Camera APIs

Before you begin, see Camera Functions.

Launching the camera and capturing images

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>

<cfclient>

<cffunction access="public" nane="getPi cCanf' returntype="void" >
<cfset opt = cfclient.canera.getOptions()>

<cfset res = cfclient.canera.getPicture(opt, false)>

<cfset inmgStr=cfclient.file.readAsBase64(res)>

<cfset docunent.getEl emrentByld(' nying').src=i ngStr>

<cfset docunent. getEl ementByld(' fil eNane').inner HTM.=r es>

</ cffunction>

</cfclient>

<div id="fil eName"/>

<ing style = "wi dth:200; height:100;" id = "nying"></ing>

<but t on onclick="i nvokeCFC i ent Functi on(' get Pi cCam , null)">getPicture -
JPEG</ but t on>

Getting images from different sources
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<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<l--- Getting picture fromdevice canera --->
<cffunction access="public" nane="get Pi ccani returntype="void" >
<cfset opt = cfclient.canera.getOptions()>
<cfset res = cfclient.canera.getPicture(opt,true)>
<cfset res='data:inmagel/]jpeg; baseb4,' +res>
<cfset document. get El ement Byl d(' nmyi ng' ). src=#res#>
</cffunction>

<l--- Getting picture fromthe al bum--->
<cffunction access="public" name="getPi cal bt returntype="void" >
<cfset opt = cfclient.canera.getOptions()>
<cfset res = cfclient.canera. getPictureFronAl bun(opt,true)>
<cfset res='data:inagel/jpeg; basebs,’ +res>
<cfset document. get El ement Byl d(' nmyi ng' ). src=#res#>
</cffunction>

<l--- Getting picture fromthe photo library --->

<cffunction access="public" nane="getPiclib" returntype="void" >
<cfset opt = cfclient.canera.getOptions()>
<cfset res = cfclient.canera. getPictureFronPhotoLi brary(opt,true)>
<cfset res='data:inmagel/]jpeg; baseb4,' +res>
<cfset docunent. get El ement Byl d(' nmyi ng' ). src=#res#>

</cffunction>

</cfclient>
<ing style = "w dth:300; height:300;" id = "nyinmg"></ing>
<button onclick="i nvokeCFCd i ent Functi on(' get Pi ccam , nul | )" >Caner a</ but t on><br >

<button onclick="i nvokeCFC i ent Functi on(' get Pi cal bm , nul I') " >al bunx/ but t on><br >
<button onclick="i nvokeCFC i ent Function(' getPiclib',null)">Library</button><br>

Setting camera options
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<cfclientsettings enabl eDevi ceAPl =true>

<cfclient>

<cffunction access="public" nane="setopt" returntype="void" >
<cfset options = {"quality" = "40", "encodi ngType" = "png"}>
<cfset cfclient.canera.setQptions(options)>

</ cffunction>

<button onclick="i nvokeCFC i ent Function(' setopt',null)">Set Canera Options</button>

</cfclient>

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPI =t r ue>

<cfclient>

<cffunction access="public" nane="getopt" returntype="void" >
<cfset res = cfclient.canera. getOptions()>

</ cffunction>

<button onclick="i nvokeCFd i ent Functi on(' getopt',null)">Get Canera Options</button>

</cfclient>

Storing the images

© 2014 Adobe Systems Incorporated. All rights reserved.

55



Adobe ColdFusion Documentation

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>

<cfclient>
<cftry>
<cfset opt = cfclient.canera.getOptions()>
<cfset res = cfclient.canera.getPicture(opt,false)>
<cfif lcfclient.file.directoryExists('nydir')>
<cfset cfclient.file.createDirectory(' nydir')>
</cfif>
<cfif opt.encodingtype eq "jpeg">
<cfset cfclient.file.copy(res, ' nydir/ing.jpg)>
<cfif cfclient.file.exists('nydir/ing.jpg )>
<cfset filObj=cfclient.file.get('nmydir/ing.jpg )>
<cf set
docunent . get El ement Byl d(' result').inner HTM.=#f i | Cbj . f ul | Pat h#>
</cfif>
<cfel se>
<cfset cfclient.file.copy(res, ' nydir/ingl.png)>
<cfif cfclient.file.exists('nmydir/ingl.png)>
<cfset filCbj=cfclient.file.get(' nydir/ingl.png )>
<cf set
docunent . get El ement Byl d(' resul t').inner HTM.=#f i | Cbj . f ul | Pat h#>
</cfif>
</cfif>
<cfcatch type="any">
<cfset alert(cfcatch. nessage)>
</ cfcatch>
</cftry>

</cfclient>
<div id="result"/>

Cleaning up

© 2014 Adobe Systems Incorporated. All rights reserved.

56



Adobe ColdFusion Documentation

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cffunction access="public" nane="cl eanup" returntype="void" >
<cftry>
<cfset cfclient.canera.cleanup()>

<cfcatch type="any">
<cfset alert(cfcatch. nessage)>
</ cfcatch>

</cftry>

</ cffunction>

<button onclick="i nvokeCFC i ent Functi on(' cl eanup', null)">Cl eanup
now</ but t on><br ><br >

</cfclient>
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Using the Connection APIs

Before you begin, see Connection Functions.

Getting the connection type

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>
<cfset conType = cfclient.connection. getType()>
<cf set
docunent . get El ement Byl d(' resul t'). i nner HTM_.=docunent . get El enent Byl d('result').innerH
TM+" Type: #conType#">

</cfclient>

<div id="result"/>

Valid connection types are Connection.UNKNOWN, Connection.ETHERNET, Connection.WIFI,
Connection.CELL_2G, Connection.CELL_3G, Connection.CELL_4G, Connection.CELL, and Connection.NONE.

Finding if the connection is offline

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPI =t r ue>

<cfclient>

<cfset cfclient.connection.onOfline('callbackl )>

<cffunction name="cal | backl" >

<cf set

docunent. get El ement Byl d(' result').i nner HTM.=docunent . get El enent Byl d('result').innerH
TML+"The nobil e connection has been | ost">

</ cffunction>

</cfclient>

<div id="result"/>

Finding if the connection is online
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<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>
<cfset #cfclient.connection.onOnline('callbackl')#>
<cffunction name="cal | backl" >
<cf set
docunent . get El ement Byl d(' resul t').i nner HTM_.=docunent . get El enent Byl d('result').innerH
TML+"The nobil e connection is active now'>

</ cffunction>

</cfclient>
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Using the Contact APIs

See the Contact Functions to understand these examples.

Creating contacts

.....................................................................................................................................................................................

<cfinclude tenpl ate="/CFI DE/ cfclient/useragent.cfni>
<cfclientsettings enabl eDevi ceAPI =t rue>

<cfclient>
<cfset res =

cfclient.contacts.create(' Joe','1234567890',"'j oe@vyconpany. com ,true)>
<cfset document.getEl ementByld(' result').inner HTM.="COpti ons obj ect:

#JSON. stringi fy(Object. keys(res))#">

</cfclient>

<div id="result"/>

.....................................................................................................................................................................................

.....................................................................................................................................................................................

<cfinclude tenpl ate="/CFI DE/ cfclient/useragent.cfni>
<cfclientsettings enabl eDevi ceAPI =true>

<cfclient>

<cfset res.addPhoneNunber ("5678234", "wor k", true) >
<cfset res.addEmail ("joe@nmuil.con', "home", true)>

<cfset cntadr=cfclient.contacts.createAddress("First street”, "North", "Indian",
"I'ndi a", "12345", "Good address forni, "hone", "true")>

<cfset res.addAddress(cntadr)>

<cfset cntorg=cfclient.contacts.createO ganization("Sci Tech", "Science", "Science
Technol ogy", "Education","true")>

<cfset res.addOr ganization(cntorg)>

<cfset res.addl nm("nyl Mdandl e", "hone", true)>

<cfset res.addCategory("Friends","hone",true)>

<cfset res.addURL("ww. | oe.cont', "home",true)>

<cfset res.addPhoto("nyDir/ing.jpg","home",true)>

<cfset cfclient.contacts.save(res)>

</cfclient>
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Finding a contact

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPI =t r ue>
<cfclient>

<l--- Searching all fields --->
<cfset cntlst=cfclient.contacts.find("Joe",["*"])>

<cf set
docunent . get El ement Byl d(' result').inner HTM.=docunent . get El ement Byl d(' result1').i nner
HTML+" Nunber of contacts - #arraylLen(cntlst)#">
<cfscript>
for (i =1; i <= #arrayLen(cntlst)#;, i =i + 1) {
wri t eQut put (" <br><br>");
witeQutput(iter(cntlst[i]));
}

</ cfscript>

<l--- Searching only the displayNane field --->
<cfset cntlst=cfclient.contacts.find("Joe",["nanme", "displayNane"]) >

<cf set
docunent . get El ement Byl d(' result').inner HTM.=docunent . get El ement Byl d(' resul t2').i nner
HTML+" Nunmber of contacts - #arraylLen(cntlst)#">

<cfscript>
for (i = 1; i <= #arraylLen(cntlst)#;, i =i + 1) {
writeQut put (" <br><br>");
witeQutput(iter(cntlst[i]));
}

</ cfscript>

<l--- Searching in the displayNane and phoneNunbers fields --->
<cfset cntlst=cfclient.contacts.find("userl 1",["phoneNunbers, di spl ayNane"]) >
<cf set

docunent . get El ement Byl d(' resul t').i nner HTM_.=docunent . get El enent Byl d(' resul t 3" ). i nner
HTML+" Nunber of contacts - #arraylLen(cntlst)#">
<cfscript>
for (i =1, i <= #arrayLen(cntlst)#, i =i + 1) {
wr it eQut put (" <br><br>");
witeQutput(iter(cntlst[i]));
}

</cfscript>
</cfclient>
<div id="resultl"/>

<div id="result2"/>
<div id="result3"/>

Getting all the contacts
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<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cfoutput>Getting all contacts</cfoutput>
<cfset cntlst=cfclient.contacts.getAllContacts(["*"])>
<cf set
docunent . get El ement Byl d(' result'). i nner HTM.=docunent . get El enent Byl d(' resul t3'). i nner
HTML+" Nunmber of contacts - #arraylLen(cntlst)#">
<cfscript>

for (i =1; i <= #arraylLen(cntlst)#, i =i + 1) {

writ eQut put (" <br><br>");
witeQutput(iter(cntlst[i]));
}

</ cfscript>

<cfout put>Getting only the phone nunbers</cfoutput>
<cfset cntlst=cfclient.contacts.getAll Contacts(["phoneNunbers"])>
<cf set
docunent . get El ement Byl d(' resul t'). i nner HTM.=docunent . get El enent Byl d(' resul t3').i nner
HTML+" Nunmber of contacts - #arraylLen(cntlst)#">
<cfscri pt>

for (i =1; i <= #arraylLen(cntlst)#, i =i + 1) {

wr it eQut put (" <br><br>");
witeQutput(iter(cntlst[i]));
}

</ cfscript>

<cfoutput>Getting only the display nanes and phone nunbers</ cf out put >
<cfset cntlst=cfclient.contacts.getAl | Contacts(["phoneNunbers, di spl ayNane"]) >
<cf set
docunent . get El ement Byl d(' result'). i nner HTM.=docunent . get El enent Byl d(' resul t3').i nner
HTML+" Nunber of contacts - #arraylLen(cntlst)#">
<cfscri pt>

for (i =1; i <= #arraylLen(cntlst)#, i =i + 1) {

wri t eQut put (" <br><br>");
witeQutput(iter(cntlst[i]));
}

</ cfscript>

</cfclient>
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Using the Event API

Before you begin, see Event Functions

Handling the back button event

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cfset cfclient.events.onBackButton("call backfunc")>
<cffunction access="public" nane="cal | backfunc" returntype="void" >

<l--- Back button pressed --->
</cffunction>

</cfclient>

i <cfclientsettings enabl eDevi ceAPI =t r ue>

i <cfclient>

5 <cfset cfclient.events.onBatteryCritical ("callbackfunc")>

f <cffunction access="public" nane="cal | backfunc" returntype="void" >
f <l--- Battery critically low --->

i </ cffunction>

i <lcfclient>

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPI =t r ue>
<cfclient>

<cfset cfclient.events.onBatteryLow("callbackfunc")>
<cffunction access="public" nane="cal | backfunc" returntype="void" >
<l--- Battery low --->

</ cffunction>
</cfclient>
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Using the File APIs

Before you begin, read File System Functions.

Uploading a file from the device

.....................................................................................................................................................................................

<cfclientsettings enabl edevi ceapi ="true" enabl edebugl og="true">

<cfclient>

<cffuncti on nane="upl oadSuccess" >
<cfset alert("upl oaded") >
</ cffunction>

<cffuncti on nanme="upl oadError" >
<cf argument name="err" >

<cfset alert(err.code)>

</ cffunction>

<cftry>
<cfscript>

cfclient.file.wite("a.txt","hello");

cfclient.file.upload("a.txt","http://<Your-CF-Server>:8500/fil eUpl oad/fil es/upl oad. c
fm', upl oadSuccess, upl oadError);

</ cfscript>
<cfcatch type="Any" >
<cfset alert("exception " & cfcatch. nessage)>
</ cfcatch>
</cftry>
</cfclient>

Downloading a file to the device
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<cfclientsettings enabl edevi ceapi ="true" enabl edebugl og="true">
<cfclient>

<cffuncti on nane="upl oadSuccess" >

<cf argunment name="obj" >

<cfset alert("downl oaded "+obj)>
<cfset alert(cfclient.file.read('b.txt"))>
</ cffunction>

<cffunction name="upl oadError" >
<cfargument name="err" >

<cfset alert(err.code)>
</ cffunction>
<cftry>

<cfscript>

cfclient.file.downl oad("http://<Your-CF-Server>:8500/fileUpload/files/b.txt","b.txt"
, upl oadSuccess
upl oadError);

</ cfscript>
<cfcatch type="Any" >
<cfset alert("exception " & cfcatch. nessage) >
</ cfcatch>
</cftry>

</cfclient>

i <cfclientsettings enabl eDevi ceAPI =t rue>

i <cfclient>

5 <cfset cfclient.file.createDirectory(' MyDir')>
f </cfclient>

Removing a directory
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<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cfif cfclient.file.directoryExists(' WDir')>
<cfset cfclient.file.renoveDirectory(' WDir', true)>
</cfif>

</cfclient>

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cfset cwd = cfclient.file.getWrkingDirectory()>

</cfclient>

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =t rue>
<cfclient>

<cfif cfclient.file.directoryExists('dirl")>

<cfset cfclient.file.renoveDirectory('dirl" ,true)>
</cfif>

<cfset dirlCbj=cfclient.file.createDirectory('dirl")>
<cfif cfclient.file.directoryExists('dir2')>

<cfset cfclient.file.renoveDirectory('dir2',true)>
</cfif>

<cfset dir2Cbj=cfclient.file.createDirectory('dir2')>

<cfset cfclient.file.copyDirectory(dir2Qoj.fullPath,dirlObj.fullPath)>

</cfclient>
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Reading afile

.....................................................................................................................................................................................
i

<cfclientsettings enabl eDevi ceAPI =t r ue>
<cfclient>

<cfset fileContent = cfclient.file.read(' MyFile.txt"')>
</cfclient>

<cfclientsettings enabl eDevi ceAPI =t rue>
<cfclient>

<cfset opt = cfclient.canmera.getOptions()>

<cfset res = cfclient.canera.getPicture(opt,false)>

<cfset ingStr=cfclient.file.readAsBase64(res)>

</cfclient>
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Using the Geolocation APIs

Before you begin, see Geolocation Functions

Getting the current position

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cfset res = cfclient.geol ocation.getOptions()>
<cfset curpos = cfclient.geol ocation. getCurrentPosition(res)>
<cf set

docunent . get El ement Byl d(' result').inner HTM.=docunent . get El ement Byl d(' resul t1').inner
HTML+"Latitude : #curpos.coords. | atitude#">

<cf set

docunent . get El ement Byl d(' result'). i nner HTM.=docunent . get El enent Byl d(' resul t2').i nner
HTML+" Longi t ude : #curpos. coords. | ongi t ude#" >

<cfset

docunent . get El ement Byl d(' result').inner HTM.=docunent . get El ement Byl d(' resul t3').i nner
HTML+" Al titude : #curpos.coords. altitude#">

<cf set

docunent . get El ement Byl d(' resul t').i nner HTM_.=docunent . get El enent Byl d(' resul t4').i nner
HTM_+" Accur acy : #cur pos. coords. accur acy#" >

<cf set

docunent . get El ement Byl d(' result').inner HTM.=docunent . get El ement Byl d(' resul t5').i nner
HTML+" Al titude Accuracy : #curpos. coords. al titudeAccuracy#">

<cfset

docunent . get El ement Byl d(' result').i nner HTM.=docunent . get El enent Byl d(' resul t6').i nner
HTML+" Headi ng : #cur pos. coords. headi ng#" >

<cf set

docunent. get El ement Byl d(' result').inner HTM.=docunent . get El ement Byl d('result7').i nner
HTM_+" Speed : #cur pos. coords. speed#" >

<cf set

docunent . get El ement Byl d(' resul t').i nner HTM_.=docunent . get El enent Byl d(' resul t8' ). i nner

HTML+" Ti nest anp : #cur pos. ti nest anp#" >
</cfclient>

<div id="resultl"/>
<div id="result2"/>
<div id="result3"/>
<div id="result4"/>
<div id="result5"/>
<div id="result6"/>
<div id="result7"/>
<div id="result8"/>

Setting Geolocation options

© 2014 Adobe Systems Incorporated. All rights reserved.


https://wiki/display/coldfusionen/Geolocation+Functions

Adobe ColdFusion Documentation

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>

<cfset res = cfclient.geol ocation.getOptions()>
<cfset res.enabl ehi ghaccuracy=fal se>

<cfset res.nmaxi nunage=3000>

<cfset res.timeout=5000>

<cfset cfclient.geolocation.setOptions(res)>

</cfclient>

<cfclientsettings enabl eDevi ceAPI =t rue>
<cfclient>

<cfset res = cfclient.geol ocation.getOptions()>
<cfset res.enabl eH ghAccuracy=fal se>

<cfset res. maxi numAge=1000>

<cfset res.timeout=2000>

<cfset watchld=cfclient.geol ocation.watchPosition(call backfunc,res)>

<cffunction access="public" nane="cal | backfunc" returntype="void" >
<cfargunment name="position">
<cfset alert(iter(position))>

</ cffunction>

</cfclient>
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Using the Storage APIs

Before you begin, see Storage Functions.

Setting/getting an item

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>
<cfclient>
<cfset cfclient.|ocal storage.setlten("keyl", "val uel")>

<cfset keyVal = cfclient.|ocal storage.getlten{"keyl")>

</cfclient>

<cfclientsettings enabl eDevi ceAPI =t r ue>
<cfclient>

<cfset «cfclient.|ocal storage.setltenm("keyl", "valuel")>
<cfset keyVal = #cfclient.|ocal storage.getlten("keyl")>

<cfset cfclient.|ocal storage.renovelten("keyl")>

</cfclient>
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Using the Video capture APIs

Before you begin, see Video Functions.

Capturing the video

.....................................................................................................................................................................................

<cfclientsettings enabl eDevi ceAPl =true>

<cfclient>

<cfset opt = cfclient.video.getOptions()>

<cfset cfclient.video.capture(opt,'funcl')>

<cffunction nane="funcl">

<cfargument nanme="nedi aFi | eArray" >
<cfset docunent.getEl enmentByld('result').inner HTM.="Opti ons obj ect:

#JSON. stringi fy(nedi aFil eArray) #" >
</ cffunction>

</cfclient>

<div id="result"/>
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